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Within the framework of social welfare services, social service agencies, particularly the 

disadvantaged groups (disabled, elderly, etc.)., Including child welfare, youth services, family 

preservation, education and social welfare services in areas such as the provision of justice is 

a tool. Efficient and effective use of this tool for the scientific level of service staff of trained 

professionals are needed. 

Social services program, the possibilities available to them in the society, and they are still 

people in distress they use their facilities which help in the best way. 

Social services program, which is the basis of education, economics, sociology, political 

science, social anthropology, psychology and social psychology courses is two years. The 

main purpose of these core courses, students in these fields as systematic disciplines does not 

teach you to gain an understanding of human needs and social problems. As well as the 

introduction of social service, social service areas, social problems, interview techniques, 

medical and psychiatric social services, family and child welfare, crime, population dynamics 

and social welfare, social work methods (social and personal work, social group work, 

community work, social welfare and social service management research) courses are taught 

within the scope of the social service. 

Personal and social problems and social understanding of deep self-interested and 

continuously improve the social service area for people looking for a career can be interesting 

and satisfying. Social services, understanding, interested in the welfare of the people, for the 

people who have leadership qualities, and a variety of amenities that provide a new 

profession. 

 



 

 

 

Social workers, social services of the Ministry of Family and Social Policies, central and 

provincial administrations, the Ministry of Health hospitals, guidance and research centers of  

the Ministry of National Education, the Ministry of Labour and Social Security and 

Employment Authority, DPT, a private rehabilitation centers, non-governmental organizations 

that provide services to disadvantaged groups, (hearing and visually impaired, schools, child 

care centers, orphanages, kindergartens and day care centers, nursing homes, reformatories), 

under the Ministry of Justice prisons and probation offices , related to family planning 

organizations, local governments and social welfare departments of social services. 

Associate Degree in Vocational Schools and Open Education Graduates Graduates are also 

studying "the continuation of the" Regulation on the areas of use of the provisions of vertical 

transmission if the quota is opened Exam (DGS) and gain the right to enroll in undergraduate 

programs. 

 

 

 

 

 

 

 

 

 



 

 

 

 

 

DEPARTMENT OF SOCIAL WORK PROGRAM 

FIRST CLASS I. MIDTERM 

I. MIDTERM  

* Will be given in the form of distance education. 

FIRST CLASS II. MIDTERM 

Course 

Code Course Title THEORY PRACTİSE CREDIT ECTS 

SHK 2 Theories of Social Work 3 0 3 7 

SP 3 Social Policy 3 0 3 7 

Course 

Code Course Title THEORY PRACTİSE CREDIT ECTS 

SOS 1 Introduction to Sociology 2 0 2 6 

PİS 1 Introduction to Psychology 2 0 2 6 

SHG1 Introduction to Social Work 3 0 3 5 

GH 1 General Law 2 0 2 4 

 English I * 2 0 2 3 

  Turkish Language I * 2 0 2 2 

 Atatürk's Principles and History 

of Revolutions * 

2 0 2 2 

 Fundamentals of Information 

Technology I 

2 0 2 2 

TOTAL    17        0 17 30 



SOS 2 Social Issues 2 0 2 7 

 English I * 2 0 2 3 

 Turkish Language I * 2 0 2 2 

 Atatürk's Principles and History 

of Revolutions * 

2 0 2 2 

 Fundamentals of Information 

Technology I 

2 0 2 2 

TOTAL    16 0 16 30 

* Will be given in the form of distance education. 

SECOND CLASS  

III. MIDTERM  

Course 

Code Course Title THEORY PRACTİSE CREDIT ECTS 

SHY 4 Social Service Management 3 0 3 4 

SHU 5 Social Work Practice I 2 8 6 10 

SP 3 Social Psychology 2 0 2 3 

 First Aid Techniques 2 0 2 3 

YYS 6 Local Government and Social Service 2 0 2 4 

TSH 7 Primary Health Care 2 0 2 3 

TSH 8 Primary Care Services 2 0 2 3 

TOTAL  15 8 19 30 

 

SECOND CLASS  

IV. MIDTERM 

Course 

Code Course Title THEORY PRACTİSE CREDIT ECTS 



SHM 9 Social Work Legislation 

Social Work Practice II 

2 0 2 5 

SHU 10 Professional Ethics 2 8 6 10 

ME 11 Conflict and Stress Management 2 0 2 3 

ÇSY 12 Human Rights and Liberties 2 0 2 3 

İHKÖ 13 Interview Techniques 2 0 2 3 

GT 14 Social Structure of Turkey 2 0 2 3 

TTY 3  2 0 2 3 

  14 8 18 30 

 

TOTAL CREDIT 70 

TOTAL ECTS CREDIT 120 

 

 

 

 

 

 

 

 

 

 

 



 

COURSE DESCRIPTION 

Introduction to Sociology 

The aim of Introduction to Sociology, students, social interaction, social communication, 

social change and the change process, social structure, social practice, such as the social 

environment and social institutions to explain the concepts in detail. 

Introduction to Psychology 

The development of psychology, the basic concepts of the subject and purpose of the 

information provided. Psychological development, behavior, perception, emotion and 

motivation. Learning the principles and theories of personality. Discusses the importance of 

psychology in social work. 

Introduction to Social Work 

This course is considered as an introduction to basic concepts of social work. After the 

introduction to the concept of social welfare course and scope of the definition of social 

science and social work as a discipline, social service, professional qualifications, the goals, 

functions and distinctive features are the main topics. 

Social Psychology 

The purpose of this course, the basic concepts and theoretical approaches in social 

psychology, on the basis of the relevant literature to transfer students. The introduction of 

social psychology, the content of the other branches of similarities and differences, brief 

historical development, social psychological research methods, attitudes, attitude change, 

social influence, aggression, aimed at examining issues such as interpersonal attraction. 

Theoretical knowledge as well as the students begin to understand themselves better in 

everyday life and is intended. 

Theories of Social Work 



Of Social Work for the realization of an effective process of service delivery needs to be 

addressed from a holistic view of the problem. This priority service discipline of social 

movement primarily focused on society and the individual continuous information science, 

sociology and psychology, theory development. The impossibility of separating the issues are 

strictly between the social sciences and the field due to the nature of the individual bio-

essential element of teaching which the subject of scientific theories is must teach. Major 

theories taught; 

• Human systems for theories of sociology and psychology. 

• Theories of social and individual change. 

• Social service in the use of theories, principles of professional practice. 

• Psychodynamic, and ecological systems, social psychology, and communication, humanism, 

community development, radical social work, empowerment and advocacy theories and 

approaches in line with the importance of these theories in terms of social services. 

• Multidisciplinary intervention in social work theory, applications and examples. 

Social Policy 

Introduction to the historical and conceptual issue of social policy, social policy, applied 

fields, social policy, social relations, the importance of application, the role of social policies 

by social workers, function and development of the European Union and the current key areas 

of social policy, policies and programs in Turkey to be addressed in the historical process of 

social policy. 

Social Issues 

To teach the theoretical underpinnings of social development and community organizing is 

designed with the concept. Analysis of the concepts of social development and social change, 

national, regional and local development strategies, community development and organization 

of the basic elements of the social development process covers the contents of the social 

problems related to social services. 

Social Work Practices 



Social Service Institutions to become familiar with the students about the general functioning 

of the institutions provided internship. During the course, students work 2 days a week as an 

intern at the institution. During this period, the students, the general functioning of social 

service institutions, professional staff of client relationships, the kinds of problems, 

interventions (micro, mezzo, macro), social service processes, organizational structure, the 

horizontal and vertical relationships within the organization, organizational culture, and so on. 

Subjects are asked to obtain information. How to practice interoperability earned theoretical 

understanding of the infrastructure provided. End of the internship the students are asked to 

write a report on the institution, the report will be discussed and students in classrooms and 

the depth of training they try to give the social problems faced by the institution. 

Social Service Management 

Social service organizations to provide information on the functioning of the items that are 

necessary and effective for the management of social services designed to examine the 

framework of modern management techniques. 

Social Work Legislation 

Definition and importance of legislation and social service institutions, legislation: Laws, 

2828, and the importance of the law, the law of 5395 and the importance of the protection of 

children, No. 633 Law on the Organization and Duties of the Ministry of Family and Social 

Policies, TC Relevant provisions of the Constitution, the disabled, the elderly, women, 

children, the legal provisions enacted for 

Interview Techniques 

Professional communication technique is the interview? Cultural differences between the 

interviewer and the interviewee, and human rights are the elements? Duration of the call, what 

are the different fields of practice and objectives? What is the importance of interaction and 

mutual relations in the meeting? Include interviewing who? Psycho-social assessment, socio-

economic analysis, individual interviews, group interviews, community organizations and 

social policies for the domain processes, and reports on evaluation of the interview. Examples 

of the interview. Individual, family, group, political mechanisms to influence (written and 

visual materials, and so on. Conversations.) 



Local Government and Social Service 

The central government, local government is the concepts? What are the kinds of Local 

Government? National legislation on local governments, local governments in the field of 

social assistance and social services are the activities? Social assistance and social services, 

and solutions to problems that are encountered in practice? The benefits of local government 

service delivery, social risk, stakeholder organizations and institutions, local governments, 

NGO cooperation, objectivity, local government and social service applications. 

Professional Ethics 

The definition and introduction of deontology, Ethics What is it? What are the morals of the 

individual features? What is Occupation? What are the Principles Profession Job Search? 

What is Teamwork? Situations in which teamwork is required? What are the professional 

contributions of Team Work? How to Study the relationship should be more professional staff 

in the team? What is the holistic approach? The concept of social services client, what are the 

qualities Applicant? Patients in the context of the Universal Declaration of Human Rights, 

client relations professional staff 

Conflict and Stress Management 

The nature of the conflict: Definition, Types and Process, Causes and Consequences of 

Conflict, Conflict Management, Conflict Management Negotiation Process, Conflict 

Management Mediation, Conflict Management Anger Management, Conflict Management 

Communication, Conflict Management Styles of Leadership, Stress Definition and Related 

Concepts Relations, Individual differences of ( persons) and the Stress and Stress Sources of 

Organizational Stress, Stress and Its Consequences, and Strategies for Stress Management, 

Stress and Mobbing (psychological abuse) 

Human Rights and Liberties 

The concept of rights, human values, the birth of the concept of human rights, development, 

and documentation of the highlights of Human Rights, Limitation of Human Rights and 

Liberties, Human Rights and Liberties Protection, Human Rights, national and international 

defense mechanisms for the protection of, human rights violations and social relationship 



Social Structure of Turkey 

Explaining Concepts and Theories of Social Structure: The Concept of Social Structure of the 

Turkish society's cultural and social structure are the features? What are the characteristics of 

Turkey's social structure of the development? Family Authority and population issues in 

Turkey, Turkey and Problems of Educational Institution, and the Transformation of 

Institutional Structure of Turkey, Turkey, Religion, Secularization and Social Transformation 

in Turkey Political Institutions and Democratization in Turkey and Problems of Working Life. 

Primary Health Care 

The concept of Primary Health Care, Disease Symptoms Monitoring, Tracking, and first 

Precautions Cautions personal hygiene and nutrition, immunization and vaccination, early 

diagnosis, Drug Use Policy, Routes of Administration, Drug Side Effects, Drug Storage, Long 

Duration in Patients Hospitalized occur Additional Diseases and Care, Rehabilitation 

Primary Care Services 

Basic Care Planning, Environmental Regulation for the prevention of accidents in elderly, 

Occupation Therapy, Behavior Therapy, Psycho-social-Contact Treatment, Care Services 

Ethical and Legal Size, Self-Care and Nutrition, Health Issues With Care Instructor and 

Precautions Possible Encounter 

General Law 

The definition of law, the importance of community life, and the principles of law, rules, and 

other social rules that regulate social life will receive information about. This section of the 

law into sections and branches of law, types of law rules, will focus on the interpretation and 

application of the Turkish judicial system. 

First Aid Techniques 

Basic first aid practices, the first and second assessment, basic life support for adults, children 

and infants, basic life support, airway obstruction, first aid, external and internal bleeding, 

scarring and wound types, regional injuries, head and spine fractures, first aid, upper 

extremity fractures, dislocations and sprains, first aid, hip and lower extremity fractures, 

dislocations and sprains, first aid, first aid diseases that require urgent care, poisoning, heat 



stroke, burns, and inhaling odd freezes, first aid, emergency handling techniques, short 

distance speed handling techniques , creating a stretcher carrying a sick or injured, first aid 

interventions in the process of social service client (fainting, shortness of breath, seizures, 

etc.). 

Turkish Language I 

What is language, theories about the emergence of language, language and culture-society 

relationship; Language Revolution: Turkish Language Association and the work of the World 

Languages: Language families of Turkish among the world languages; Turkey Turkish: Voice 

features, Morphology, Syntax, , Spelling, Punctuation, Correspondence: Resume, Application, 

letter, business letter, telegram. 

Atatürk's principles and reforms-I 

The Ottoman Empire Order and Reforms in the Ottoman Empire and Fall of the Disruption; 

Anatolia, Mustafa Kemal Pasha, Organization of National Struggle Opening of the First 

Parliament, Military and Political Developments Between 1920-1922, Revolution and 

Counter Reactions; Constitutional System; Republican Era Domestic and International 

Politics of the Turkish Revolution, Basic Characteristics and Intellectual Movements, Law, 

Education, Economy, and Social Life; Ataturk's Principles and General Characteristics of 

these principles; Evaluation of Kemalism from an ideological perspective. 

Fundamentals of Information Technology I 

The computer operating system, the general definitions, hardware, information, technical 

specifications. The general definition of operating systems. Windows operating system, 

Microsoft Office programs, presentation, office applications are? Presentation Preparation 

Techniques 

English I 

Markers; Prepositions: Place, Time, Motion, Singular and Plural Nouns: Countable and 

uncountable nouns; Times: tense, present continuous tense, past tense structures; Paradigms: 

Will, Should, Should not, Must, Must not, Can; Comparative structures; Pronouns: pronouns, 



possessive pronouns, adjectives, positive sentences, negative sentences and interrogative 

sentences; Conjunctions: And, But, When, because 

Fundamentals of Information Technology II 

General Information About the Office program, Word General Usage Using the File Menu in 

Word, Word Using the Edit Menu, View Menu Using Word, use Word Insert menu in Word 

Format to Use Menu, use the Tools Menu in Word, use Word Table Menu, Excel Required 

Use of Basic Application Menus, Powerpoint Essential Practice for the Use of Menus 

English II 

Time: Present tense, past tense, past tense, future tense structures; Modes: Might, Could, Can, 

Must, May, Envelopes: Location, Direction, Purpose, adverbs, adjectives: Order of adjectives, 

Comparative, Superlative forms; passive Structure: Current, Wide, The Past, the Future also 

passive voice; Conditionals; Adjective Clauses, Relative Clauses; Verb Structures: TO,-ing, 

noun clauses; Adverbial Clauses; Comparative Constructions. 

Turkish Language II 

The right to use their native language for gaining the skills that the students who come to 

college in gaining skills in order to enhance the ability of producing ideas and thinking in this 

area is based on the course of writing, punctuation, and spelling rules, rules of composition, 

writing exercises related to these types of writing are discussed and examples. In addition, 

various novels, poetry books and plays are read and discussed. Reading plays in the 

classroom, a variety of techniques and diction lessons are applied stress and intonation. 

Ataturk's Principles and Revolution II 

The Ottoman Empire Order and Reforms in the Ottoman Empire and Fall of the Disruption; 

Anatolia, Mustafa Kemal Pasha, Organization of National Struggle Opening of the First 

Parliament, Military and Political Developments Between 1920-1922, Revolution and 

Counter Reactions; Constitutional System; Republican Era Domestic and International 

Politics of the Turkish Revolution, Basic Characteristics and Intellectual Movements, Law, 

Education, Economy, and Social Life; Ataturk's Principles and General Characteristics of 

these principles; Evaluation of Kemalism from an ideological perspective. 


